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1 Overview

1.1 Introduction to DayNotez Desktop

While at your desk, use this powerful Windows application to enter and review your DayNotez
™ entries. Powerful grouping, filtering and sorting let you organize the way you work.

The DayNotez™ Desktop for Windows companion application allows you to add, modify,
archive, and print your entries at your desktop as well as on your Palm or Pocket PC device. The
DayNotez conduit for HotSync Manager updates your Palm device and desktop during normal
synchronization. The DayNotez ActiveSync conduit updates your Windows Mobile Pocket PC
device when connected.

DayNotez™ Desktop Key features:
· Organize your entries using multiple views. 
· Use the calendar to quickly locate a date. 
· Review your entries in a page format using the Day view. 
· Powerful Custom view groups and sorts by multiple attribute. 
· Conduit uses HotSync technology to synchronize with your Palm device. 
· ActiveSync conduit to sync with Pocket PC devices.
· Organize and filter your entries using categories. 
· Customize the look with display preferences. 
· Print your entries using several formats. 
· Filter by search string.
· Spell checking, including "LiveSpell Check", and auto-correct.
· Password protected data.
· Associate a contact or name and keyword with each entry.

1.2 What's new

Changes in version 1.6

Here is a quick summary of major new features in version 1.6, followed by a more detailed list:

· Support for syncing with Pocket PC devices
· Support for Rich Text (Bold Underline Italic Bullets Alignment, etc.)

when syncing with Pocket PC
· Category Coloring in now saved in the data file itself to prevent

corruption.
· The Category preference dialog no longer exists. Color options are

handled in the "Edit Categories" dialog itself.

+ Fixed: issue with "Filtered" status indicator showing in new installations
+ Added: Special Paste (Shift-Ctrl-V) to paste plain text from clipboard if available
+ Chang: Template toolbar dropdown is now sorted by template name
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+ Added: (PALM) Added hotkey (F12) for "Pause" durring playback of voice memos
+ Fixed: issue with refresh when there are no entries causing an error
+ Fixed: issue with large "NEW" button on entry screen no being accessible at times
+ Fixed: issue with no tab area available when a valid data file is open
+ Chang: (Palm) "Edit" tab to default to "Arial" font so that palm bullets show up
+ Fixed: issue with Win98 systems not liking double backslashes in file paths

Changes in version 1.5

Here is a quick summary of major new features of version 1.5, followed by a more detailed list:

· Export to HTML, CSV, Text, etc.
· Support for Keywords and Followup flags
· Support for entry templates (add, delete, modify or use existing

handheld side templates)
· Ability to duplicate and existing entry

· Password prompting when showing DayNotez Desktop after it has
been minimized

· Text filter now searches both entry text and keywords

· Ability to limit the date range of entries to work with, making
DayNotez load faster in some cases

· Support for playing voice memos

· Ability to quickly set an entries date and time to "NOW".

Detailed list:

- Added: New status bar panel to indicate "All" entries are being loaded, or "Part" for partial load
based on a date range (see previous bullet item)
- Added: Disabled more controls for a more "user friendly" state when no data file is open. This should
prevent users from hitting buttons that cause failures.
- Added: Ctrl-Tab to sequence through the three tabs
- Added: Better detection of true password protected data files. Other MDAC/ADO errors should now
be reported and not interpreted as login issues
- Added: Template Editing (see menu item "Edit->Edit Templates...")
- Added: Time, Days Since, and Last Modified to CSV export
- Added: Large button on blank screen to select a data file/hotsync user when none is currently open
- Added: Status bar indicator that indicates when the custom view is filtered
- Added: Latest DayNotez handheld build (refer to readme for handheld app for changes)
- Added: Updated conduit (minor wording changes, etc.)
- Added: ability to disable autoURL detect in editor
- Added: ability to define "header" background color in Day View
- Added: Custom Preview, Entry, and Day View background colors are now reflected in "Font" preview
boxes in the prefs dialog
- Added: Ability to define if the DateNav list initially starts out fully expanded or collapsed
- Added: Voice Memo panel below DateNav for listening to voice memos.
- Added: Menu item in "View" to exposing or hiding the Voice Memo panel
- Added: Ability to Duplicate an entry. While in the entry tab, right click for context menu. Entire entry
is duplicated with the exception of date/time, which is set to current date/time
- Added: A "Now" button next to the date/time editors in the entry tab toolbar. Clicking on this item will
reset the current items date/time to the current date/time
- Added: Ability to set a limit to the entries being loaded (to save load time and memory). See
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"General Preference". Changes made to this will not take effect until after a restart of DayNotez
Desktop or until you change users. 
- Added: Enhanced menu/toolbar look and feel
- Added: Filter Text (search) will now also apply the search to the keyword. eg: Find "XYZ" in note text
OR keyword
- Added: Persistent category (saved on a per-user basis)
- Added: Private and Follow up indicators in custom preview pane.
- Added: URL links in custom preview pane.
- Added: Follow up Flag to printouts
- Added: Private and Follow up to "default new entries" preferences.
- Added: Password protection when restoring from minimized (If password is enabled)
- Added: Password protection when un-hiding private records ((If password is enabled)
- Added: Basic block indent/outdent (Shift+Ctrl+] = indent /  Shift+Ctrl+[ = outdent)
- Added updated printer driver. Should not be noticeable to most.
- Added: Custom tab context menu item for Setting and clearing the follow up flag on mulitple entries
- Added: Custom tab context menu item for assigning a keyword to mulitple entries (basic text edit
field for now)
- Added: Custom tab context menu item for assigning a contact to mulitple entries (basic text edit field
for now)
- Added: Contact Name completion/lookup/edit added to Entry Tab.
- Added: Contact Name completion/lookup/edit added to Custom Tab context menu dialog.
- Added: Keyword completion/lookup/edit added to Entry Tab.
- Added: Keyword completion/lookup/edit added to Custom Tab context menu dialog.
- Added: Change the status bar just a bit to make a space between user/entry section and
"caps/num/scroll" indicators
- Added: Entry tab now displays only a single "New" button if you select a calendar date with no
entries. Some users were confused when the Entry tab always displayed a - Added: Toolbar now
again shows tooltip when you hover over them with the mouse.
- Added: Reports now contain "Category / Keyword" information
- Added: DayView now contains "Category / Keyword" information
- Added: "Category/Filter" toolbar to the view menu.
- Added: Ctrl-Shift-F as a hotkey for the text filter.
- Added: "Aggressive Live Spell Menu" option in prefs. If you have problems right clicking on the live
spell "squigglies" to get a context menu of suggested words, then enable this option.
- Added: Added a prompt for overwriting existing files when exporting.
- Added: You can use Alt-D to jump directly to the Date edit from the entry tab.
- Added: Printout templates modified to reduce the amount of empty space between entries.
- Added: Header for each entry in printouts now updated with same font of the user defined print font.
- Added: Page header font now reflects font selected by user for printout.
- Added: DayView Tab "Date Header" area now set to same font selected for the DayView entrys.
- Added: Re-arranged main menu to be more in line with other standards.
- Added: You can right click on the Custom list and choose "Export->Text/HTML/CSV" and do the
same type of exports that you can do with the
standalone export tool we offer non-DayNotez Desktop users.
- Added: In the Entry view, there is now a toolbar field for Keyword.
- Added: Entry view, there is now a checkbox to set or clear the followup flag.
- Added: Entry view, the toolbars now wrap instead of hide with a cheveron. This is to avoid confusion
for customs who didn't have the entry area large enough to show those items.
- Added: Custom view, the Keyword field is now visable in the preview pane.
- Added: Custom view grid, you can use the field chooser to add Keyword and followup fields to the
list of columns
- Chang: Improved speed time to create a new entry when there was a large data file.
- Chang: DateNav list and Custom list should now always highlight the current item and not the
parent item if the current item is the "topmost" grouped item
- Chang: Double clicking on Preview pane header will now always take you to Entry tab with current
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entry
- Fixed: bullets/numlist insertion when editor is not in "edit" mode
- Fixed: More aggressive refresh after a hotsync.
- Fixed: Tab order in entry area.
- Fixed: Keyword printout from custom view
- Fixed: Copyright date on Help/About box
- Fixed: Removed 3d font effect in password dialog for easier reading
- Fixed: Removed ability to click on date/time in status bar to jump to today since it had too large of a
boundary
- Fixed: Select HotSync User now centers on window
- Fixed: Password dialog now centers on window
- Fixed: Reworded dialog that informs users they need to sync prior to accessing their data
- Fixed: security hole in encrypted data files.
- Fixed: the "Save" icon to only be enabled when changes have actually been made
- Fixed: When renaming one category to the same as another (Case Sensitive), the two are merged
- Fixed: Category Edit dialog now correctly handles setting the proper category in the list
- Fixed: Category Edit dialog now properly returns the selected category
- Fixed: Category Edit dialog properly disables appropriate buttons
- Fixed: print engine only printing 1 page
- Fixed: When multi-selecting entries in custom view, same entry would print multiple times if
grouping was included.
- Fixed: Preferences (esp. category color) should not get wiped out if there are issues when initing the
app.
- Fixed: The data file name is based on the hotsync name, which may contain chars that are not legal
for filenames. DnD now subst. _ for illegal chars.
- Fixed: Persist cursor position in entry text after doing a "save".
entry for a previous date when they clicked on calendar dates with no entries.
- Fixed: The "Find" feature is no longer available unless you are in the entry tab. This is to help with
confusion where some expect the "Find" to look through all entries as opposed to just the current one.

Changes in version 1.3

+ = New Features
- = Bug Fix or Change in behavior

- Added drag and drop of entries from either list to calendar to change date of entries

+ Day View now uses category colors for entry headers

+ Main menu is now detachable

- Added menu item "View->Toolbars->Contact" to restore or hide contact entry field toolbar

- Fixed problem with selecting multiple entries in the custom list. They now should not loose focus
while control or shift clicking.

- DateNav calendar is better at reflecting days with entries after a new, delete, or change of entry date.

- Fixed problems with gradient header printing with some systems.

- Saves and Restores printer preferences more reliably.

- Cleaned up printouts. Made more consistent. Removed truncation problem for right justified fields. 
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- Print Preview now more accurately reflects how the printout will be produced.

Changes in version 1.2.5

- Added the ability to view and edit the "Contact" field new to version 2 on the handheld side.

Changes in version 1.2

+ Password protection and data encryption. 
+ Bullet list behavior that mimics the palm side.
+ Numbered lists.
+ Options for Start of Week being Monday or Sunday in DateNav.
+ Printing from Custom View now prints the entries in the same order as displayed in the list.
- Added Printing preferences for optional printing of Title, Header, and Footer lines.
- Added Printing preference to set user definable report title.
- Added new Look to printouts, including preference feature to gradient color code entry sections
based on category color settings.
- Added icons to the preference tabs for easier visual clues.
+ New "Live Spellcheck" option. This give you the ability to have real time spell checking when
entering text. (Please see the above notice about obtaining the new dictionaries required for this
release).
+ Autocorrect spelling option
+ Ability to use MS Word user dictionary as part of spell check.
+ Printing Font: The "Print Font" for your entries is now a separate preference. We will no long be
setting the print font based on each tab. Additional "Print Options" will be added later. Also note that
the Print Font is restricted to "printer" fonts only. Previously, you could choose a "Screen" font which
did not print correctly.
+ Preference "Enable Column Filters" to turn on and off the filter column options (for those none
power users, this makes the columns look a little more readable).
+ Time Rounding for New Entries: There is a preference on the "Entry View" prefs page to set time
rounding. You can also choose a "Hard Time" if you wish all of your entries to be set to a particular
time.

- Fixed the way that Page Setup is initiallized. Some users reported having trouble with Page Setup
even if they had a default printer defined, but that printer was off-line/networked. Now the Page Setup
dialog is only ever initialized if you actually summon it from the menu. This should also make for much
faster startup time for users that had either "Windows Printers" or poorly written/out of date printer
drivers.
- Fixed a bug where you were not able to use the splitter bar to resize the preview pane if it was
initially not shown (hidden) when you started the application.
- Added the "15th" user definable custom color control. It was one short previously.
- Fixed "out of index" problem when you had the list of entries filtered in some way, and then did a
group operation in the custom grid which put the items out of the filtered set. e.g. You select "don't
show archived", select 3 entries in the custom grid, right-click and select "Archive", and then the "out
of bounds" error would occur.
- Preview Pane in the Custom View tab now saves and remembers it's height.
- The conduit now has better behavior for it's z-order. What that means is that if you choose to have
progress turned on at sync time, DayNotez will no longer force itself to be the top dialog on your
screen.
- DayView now resets itself to the top position when a lot of entries exist for that day
- Rearranged the categories in the preferences to be in a more logical order
- Auto Refreshed to category filter dropdown upon "Refresh Data" menu option and on a hotsync.
- Fixed error message that appeared when there was no default printer assigned. This could prevent
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you from properly exiting the application. Now if no printers are defined, you are no longer allowed to
print or set page settings.
- Fix printing problem on ceratin systems where the last line or more of text did not print.

Changes in 1.1

- Updated printer driver. Appears to fix problems seen when printing with certain fonts that
caused infinite pages to be printed.
- Creating new entries now properly focuses current entry on the newly created one instead of the
top entry listed for the day in the DateNav list.
- Fixed missing "Next Day" button behavior on some Win9x systems.
- Fixed "New Category" to not allow duplicate categories.
- Conduit does a much better job at detecting multiple desktop syncs, which previously caused it
to skip hotsyncs because it thought nothing had changed.
- Updating the lists due to a cateogry or text filter change now defaults to the selecting the most
recent entry upon completion instead of the oldest.
- Fixed a bug in "Control-Click" on calendar which may have not placed the next entry on the
date actually clicked.

- Added preferences for color coding list entries by category.
- Added support for "Excel Like" filtering directly from the column headers in the custom view.
This is yet another "power user" feature.
- Added font selection for DateNav Calendar so users with non-English language systems can
view calendar with a different font.
+ Changed the entry page category selector to use a default_font to try to support non-English
fonts.
+ New icon to represent private in both custom list view and entry. (Looking for suggestions for
a new "Archive" icon to replace the current one.)
- Added new column "Days Since" to refelect the number of days since the entry date.
+ Changed behavior of DateNav list to "Expand All" upon refiltering the list.

1.3 Installation

The following steps will get you up and running with DayNotez.

(Palm Users)
1) Open the downloaded Zip file and extract all the files into a temporary directory.  Run the setup
program from that location.  Or, if you have downloaded the self-extracting Zip file, run that executable
and follow the instructions.

2) At the completion of the install script an option is provided to install the application on your Palm
OS device. Select that option.  If you have multiple Palm Users defined on your desktop, a selection
list will be displayed.  Pick the user where you want to install DayNotez.  Click the Done button when
the Install Tool dialog is displayed.

3) Perform a HotSync.  The DayNotez application is now installed on your handheld and ready for
use.
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4) After making entries on the Palm, synchronize again.

5) Run the desktop application either by double clicking the DayNotez icon in the folder opened by
install, or by the start menu item found on "Start->Programs->Natara Software".

The license agreement allows you to evaluate DayNotez Desktop for 30 days before purchase. After
30 days of use, DayNotez Desktop will no longer synchronize changes between your Palm device and
your desktop.

(Pocket PC Users)

The following steps will get you up and running with DayNotez.

1) Place your Pocket PC device in its cradle and ensure the device has an ActiveSync connection.

2) Double-click the downloaded setup file to start the installation wizard. Follow the wizard
instructions.
   
3) Once the installation wizard finishes, DayNotez will automatically start on the Pocket PC. If the
DayNotez Desktop application and synchronization support option was chosen (the default),
DayNotez will also be started on your PC.
   
If you already have DayNotez installed on your PC and need to install DayNotez to your Pocket PC,
use the "Install DayNotez on PPC OS Device" shortcut located at Start/Programs/Natara Software.

Note: If, after the 30 days, you decide NOT to purchase a license, you should uninstall the
product. Failure to do so will result in HotSync Manager not backing up your DayNotez Palm data,
and you run the risk of loosing your entries if your device crashes and needs to be restored. HotSync
Manger, by default, stops making backups of data file for any Palm application that has an installed
conduit (such as DayNotez Desktop). 

1.4 Uninstalling

Use the Add-Remove Programs control panel document in Windows to uninstall DayNotez Desktop
from your desktop. 

Note: Because DayNotez Desktop creates a data file that has user created information in it, it
does not remove all files during the uninstall. This is done on purpose. It gives you a chance to save
your data file in case you wish to re install later, or keep a backup of those entries. If you wish to totally
remove all files, just use Windows Explorer to delete the DayNotez directory where DayNotez Desktop
was installed.

1.5 System Requirements and Limitations
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1.5.1 Pocket PC Devices

 Here is a list of requirements to run DayNotez on your Palm OS device.

· Windows Mobile based 2003, 2003SE and WM5.0 Pocket PCs; may work with PPC 2000 & 2002
devices but is not officially supported)  

· Requires .NET Compact Framework 1.0 SP3 (included and installed with DayNotez setup if not
already installed)  

· Requires SQLCE Server 2.0 (included and installed with DayNotez setup if not already installed)

1.5.2 Palm OS Devices

Here is a list of requirements to run DayNotez on your Palm OS device.

· Any handheld device running Palm OS 3.X or greater.

· About 170k free memory for the application (not including memory for notes) 
· Works on both black & white and color displays

Note: DayNotez also works great with the Stowaway™ Keyboard (and works with the GoType™
keyboard also), but is not required.

1.5.3 Windows Desktop Requirements

Here is a list of requirements to run DayNotez Desktop in your PC.

· Windows XP,2000,NT4

· Hotsync Manager 3.0 or greater

· ActiveSync 3.8 or greater

· Jet OLE DB driver version 4 or above.

· Microsoft Database Drivers (MDAC) 2.6 or above

1.5.4 Limitations

Here are some limitations to be aware of (both desktop and Palm)

(Palm only... These limitations do not exist when syncing with a Pocket PC device)
· Limited to 15 categories (Palm compatibility restriction)
· Limited to 32k note size.
· Font formatting (bold, italic, underline, etc.) is not supported. Only simple text. This is due to

limitations in the Palm input fields.

1.6 How to buy DayNotez Desktop

For handhelds running the Palm OS (Treo 650, Tungsten, Zire, etc.)
You can purchase a license for DayNotez for Palm OS Desktop Edition from the 
Natara website at http://www.natara.com/daynotez/purchase.cfm.

For handhelds running Pocket PC (iPAQ, Axim, Loox, etc.)
You can purchase a license for DayNotez for Pocket PC Desktop Edition from the 

http://www.natara.com/BuyNow?Product=DayNotezDesktop&Retailer=Natara&Version=3.0.5.2782&Days=-2&Pt=3
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Natara website at http://www.natara.com/daynotez/purchase.cfm.

After purchasing a DayNotez Desktop license, you will receive a registration number by
email (usually within 24 hours). Follow the instructions in the email to enter your
registration number in the registration number dialog.

Registration dialog

Note: Registration numbers for DayNotez Desktop always begin with 057 or 056 (557 or 556 for
evaluation extensions). If you have a number that begins with 054 or 052, you have a DayNotez
(handheld only) registration number. This number will NOT work with DayNotez Desktop to allow you
to synchronize with the desktop application. You will need to purchase an upgrade from DayNotez to
DayNotez Desktop. See the Natara web site for more information about upgrading

Lost Registration Numbers

If you misplace your registration number, visit the Natara web site 
http://www.natara.com/mynatara to request your registration number.

2 DayNotez Desktop user interface

2.1 The main screen

2.1.1 Main Screen layout

This is the main screen for working with your DayNotez entries in the application.

http://www.natara.com/BuyNow?Product=DayNotezPPC&Retailer=Natara&Version=3.0.5.2782&Days=-2&Pt=3
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Toolbars: Quick button access to commonly used commands. Three toolbars exist,

· main toolbar, 

· custom toolbar, 

· help toolbar. 

See the Toolbars section for more details.

DateNav: The entry navigation portion of the screen, otherwise known as the DateNav, is where you
can quickly jump to entries based on dates. It consists of a calendar in the upper portion that has bold
dates indicating days with entries, and an Notes List view in the lower pane similar to the entry view
on your handheld DayNotez application.

Tab Views: In this section of the application is where you see and edit existing entries. There are
three "tab" views here:
· DayView tab for viewing a day of DayNotez entries.

· Entry tab where you can edit a single DayNotez entry, and
· Custom tab which allows for user customizable grouping and sorting of DayNotez entries.

Status Bar: The status bar gives you indications of the data file you are working with, along with
keyboard status and current date and time.

2.1.2 DateNav Panel

2.1.2.1 Calendar

The calendar is displayed in the top part of the DateNav panel, which is located on the left side of the
DayNotez Desktop display.
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Calendar

From here, you can select the day to view. Click on a day to set show that day in the Day View. If the
date is a bold date, that indicates that entries exist for that day (based on your current category, text,
archive, and private filters). If the date is bold, you will also move the currently selected entry to the
first one on that day listed in your Notes List.

Double clicking on a date will also bring the Day View into display. If there are entries for that day, they
will be displayed. Otherwise the Day View will display no entries.

Click on the left or right arrows at the top of the calendar to move forward and backwards a month at a
time. 

Click and hold on the month label at the top of the calendar have it present a scrolling list of months
to quickly move to a particular month.

Hint: If you Ctrl-click on a date in the in the calendar, you will create a new entry with the date
automatically set to the date you selected. This is a very handy way to quickly create DayNotez entries
on specific days.

Displaying Multiple Calendars

Four calendar view

You can show more than one calendar month at a time. Use the "splitter pane" handles on the left
and bottom of the calendar area to make the pane larger. The larger the area, the more months will be
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displayed at one time.

Splitter handle

2.1.2.2 Notes List

The notes list area is similar to the note list display on the handheld side

Notes List

From here you get a list of all your entries (based on your filter settings), grouped by day. Each row
represents a single DayNotez entry and shows its assigned time and a short view of it's beginning
text. 

Rows that have a + or - box are grouping rows. You can expand or collapse those groups by clicking
on the box. Alternately, you can right click on the list and select "collapse all" or "expand all" to
collapse or expand the entire list.

Selecting an entry in this list makes that entries day the currently selected calendar day, and the entry
the currently selected entry. Double clicking an entry will bring the "Entry Tab" into display, where you
can edit that entry. You can also right click on the selected entry to delete it.

Use the Preference dialog to reverse the sorting order of the days listed.

Hint: to sort each day by the time or text, simply click on the column header with your mouse.
Click again to sort the opposite direction. The arrow indicates sorting direction. Control-click to not sort
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by the column.

2.1.2.3 Voice Memo Player (Palm only)

If you use a device which DayNotez supports making voice memos, then this will be of interest. When
you select an entry that has a voice memo associated with it, the panel at the lower portion of the
DateNav will display the saved sound file. 

If you do not see this panel you can make it visible by selecting menu item "View->Voice Memo
Control". You can also hide the display of this panel by choosing that menu item again. There is little
point in displaying it if you do not have any voice memos recorded from your handheld. You can also
close/hide the panel by clicking on the small [x] in its upper right hand corner. The panel can be
resized (up and down) by dragging on the sizer bar at the very top edge of the panel.

To play an available voice memo, first select it by clicking on it in the window. In this case, the voice
memo is named "27-1615-sd128.wav". Once highlighted, click the green "play" button to hear it. Click
the yellow "pause" button to pause, and the red "stop" button to stop playing it.

The voice memo panel can show multiple .wav files for a single entry. This is certainly possible, since
you could have multiple recordings stored on different storage cards. It is also possible that not all of
the voice memos belong to the particular entry you have selected. Voice memos are identified by a
timestamp. If you choose to save all of your entries to the same time, then a single voice memo might
be identified with multiple entries.

About the naming convention: in the example above, the voice memo belongs to an entry that was
assigned the 27th of the month at 4:15pm and was saved on a storage card named "sd128".

Voice playback is done in the background. This allows you to play a voice memo while possibly
transcribing it into the text of an entry.

Double clicking on the file name passes the file to the Windows operating system for playback. Be
warned that due to some of the recording characteristics of some handheld device (speed/bit rate,
etc.) Windows players some times have difficulty in playing certain files.

Note: Editing, deletion, and creation of voice memos is not a capability of DayNotez Desktop at
this time.

Note: Pocket PC users: voice annotations from the Pocket PC show up embedded within the
text of the entry. Simply double click to listen to them.
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2.1.3 The Tab views

2.1.3.1 Day View Tab

This is the Day View tab. It displays a days worth of entries. The entries shown are based off the
currently selected day, current category filter, and current text filter if any.

Day View Tab

Previous / Next Entry Day button: Use these buttons located to the left and right of the Day View
date to move to the next and previous dates which contain DayNotez entries. These buttons do not
more a day at a time, but skip to days where entries exist. The Day View can be positioned on a date
with no entries by selected a non-bold date on the calendar.

Day View Displayed Date: This label indicates the current day displayed in the Day View text area.

Entries for this Day: This area show multiple entries for a single day. Each entry begins with that
entries time and category, followed by the entry text indented slightly to the right.

Hint: Text which represents URLs (example http://www.natara.com) or mail addresses (example
mailto:support@natara.com) are turned into true hyperlinks. They are usually represented as
underlined text. Clicking on them while in the Day View will either start your web browser and take you
to the URL, or open your email program with the "mailto:" address in the Send To box.

2.1.3.2 Entry Tab

The entry tab is where you make changes to your DayNotez entries.
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Entry View

Entry Toolbar: This toolbar shows the details for the current DayNotez entry. You can change the
date, time, category, private, or archive settings here.

Entry Editor area: This is where you make all changes to your DayNotez entry text. This is the only
place where changes to text are allowed.

2.1.3.3 Custom Tab

The Custom tab contains the user customizable list and preview pane. It is the "powerhouse" of
DayNotez Desktop, allowing custom grouping, sorting, and printing, and multi-selection action based
activities. Those of you familiar with Microsoft Outlook and it's flexible lists should feel right at home
here.
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Custom View

Custom Entry List: This is the user customizable entry list. It allows you to sort and group DayNotez
columns however you please. You can also perform group actions on multiple entries from here. Just
select the entries you want to deal with, and right click to bring up a context sensitive menu of actions
you can perform. For example, you may select multiple entries and choose to set their categories all to
"Business", or you might want to mark them all for archive. 

Note: Printing while on the Custom View allows you to print all selected the entries. Having no
entries selected means you will print all the entries.

Hint: Standard windows selection rules apply here. To select a random set of entries, hold the
control key down while right clicking. To select a range of entries, select and entry, the shift click on
the last entry. This selects all entries from the first through the last. You can use a combination of
these two methods to select the entries you want.

Preview Pane: This pane shows the "Current" entry selected in the custom view. It is usually the
same single entry that is displayed on the Entry List. Although you can select and copy text from this
display, you can not edit your entries here. For that, switch to the "Entry Tab". For Pocket PC users,
this data may be shown in Rich Text format. It is always plain text for Palm users.

2.1.4 Status Bar

The status bar is located at the bottom of the main window. It has information and features that you
may find useful. Here is a breakdown of its components
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· The first panel contains the name of the current HotSync users who's entries are begin displayed.

· Next is the entry count status. This is the current number of filtered entries available for viewing.
· The next 3 panels are very common in windows programs, and simple display the state of your

keyboard Caps Lock, Num Lock, and Scroll Lock keys.
· Last, on the far right of the status bar, is the current date and time. 

Hint: Use your mouse to right click on the status bar's Date and Time display to make the
calendar jump to today's date. This is the equivalent of clicking on the "Goto Today" button in the
calendar section.

2.2 Dialogs

2.2.1 About Box

The About box gives information about the particular version of DayNotez Desktop you happen to be
running. You can access the about box by using the Help menu "About" item.

About Box

Current Version

This number indicates the current version, or release, of DayNotez Desktop you have installed. It does
not represent the version of DayNotez that is installed on your handheld device. To find the handheld
version number, bring up the menu "Options->About" while running DayNotez on your device.

The version number is broken up into three parts, Major Release.Minor Release.Maintenance
Release. Major release numbers usually change when significant changes or totally new software is
released. Minor release number changes usually indicate that new features have been added to the
current Major release. Maintenance release numbers change when bug fixes and internal changes
have been made to the product. For example, if DayNotez Desktop added support for sending email,
that would probably be indicated by an increment in the "Minor Release" number, since it is a new
feature. If the only change to the application are fixes to the printing behavior to fix problems
experienced by some users, that would be cause for a Maintenance release. 
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Build Number

The build number is a constantly incrementing number that usually only gets reset to 0 when a major
revision is released. This number is important when reporting problems with the product. Don't worry if
you see the build number change several numbers between release notices. There are usually several
"build updates" that are internal to Natara Software that are not publicly available. 

2.2.2 Change Date Dialog

This is the date selector dialog.

Date Selector dialog

This dialog appears when you choose to the "Date..." option in the context menu of the custom list. If
you have one or more entries selected in the custom view, changing the date here will assign that
date to all the selected entries.

You can change the date by either manually entering the date into the text box, using the numbers
and arrow keys, or by activating the drop down calendar and selecting a date with the mouse.

2.2.3 Edit Cateogries Dialog

The Edit Categories dialog is where you can modify your current category list.

This dialog allows you to add, remove, rename, and color categories that are currently in your category
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list.

To color a category, select the category name in the list. Then use the color selector on the lower right
of the dialog to assign it a color.

(Palm Only)
Due to current limitations on the handheld device, there is a restriction of 15 total categories that
can be maintained. Category names are also limited to 15 characters.

Note: The "Unfiled" category can not be modifed except for its color. You can not rename or
remove it from the list.

New Category

This allows you to add a new category to the current list of categories. You are limited to 15
categories.

Delete Category

This allows you to remove the currently selected category. You are given the option to also deleting all
the entries assigned to that category, or moving them to "unfiled".

Rename Category

This allows you to change the name of the currently selected category.

2.2.4 Open HotSync User Dialog

This dialog allows you to choose a user that you wish to view DayNotez entries for. You can access
this dialog from the "File->Choose User..." menu item, or by selecting the status bar section with this

icon 
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User Selection dialog

Choose a user in the list box and select OK. DayNotez Desktop attempts to open the DayNotez
entries data file created when the user first synchronized.

Hint: You can double click the name in the list to quickly choose a user.

Note: (Palm Only) It is necessary for a DayNotez user to have done at least one successful
synchronization with their handheld device after installing DayNotez before DayNotez Desktop will
allow you to open their entries.

Note: This dialog presents a list of ALL users this computer has synced DayNotez with.

2.2.5 Password Login Dialog

If the data file you are attempting to open is password protected, you will be presented with the
following dialog:

Password Login Dialog

You must enter the correct password which was assinged to the data file here in order to open and
view the entries in that data file. You can assign or change the current password in the Password
Protecion Dialog, which is available from the File menu "Password Protect..." item. 

Warning: If you forget your password, you risk loosing all the data in your data file, especially
those entries which have been archived off the handheld device and now only exist on the desktop.
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2.2.6 Password Protection Dialog

The Password Protection dialog allows you to enable, change or clear the password protection
assigned to your data file.

Password Dialog

Old Password: Enter your old password here. Leave this blank if your DayNotez data file currently
has no password assigned to it.

New Password: Enter the new password you would like to assign to your DayNotez data file.
Leave this blank to clear the password protection feature. This is the password
that will be required to open the data file from now on. You will be prompted to
enter this password the next time you open the data file from DayNotez Desktop.

Verify Password: Enter the same password as the you did in the New Password field. This is used
to verify the correct entry of the passoword.

Hint: Leave the new and verify password blank to "turn off" password protection. Leave the "Old"
password blank when first enabling password protection.

2.2.7 Preference Dialog

2.2.7.1 General Preference

This is the General section of the Preference dialog.
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General settings.

Tab Location: Indicates where the tabs that label the "Day View", "Entry", and "Custom" are located
relative to the view itself. By default, the tabs are located at the top.

Date Navigator: This section deals with the calendar and Entry list.
· Font: Choose the font that is used in the entry list.

· Show Column and Row lines: draws the vertical and horizontal lines in the entry list.

· Show most recent days at the top of list: determines to sorting order (date only) of the entry list.
If you would like the most recent entries to be displayed at the top of the list so you don't have to
scroll down all the time, check this option.

· Start Collapsed: The DateNav list (on the left) is initially started with all the days collapsed if
checked.

· Calendar Font: Choose the font that the Month Calendar will use. This is particularly handy for
users of non-english font sets.

· Start of Week: Select if the month calendar in the DateNav shows Sunday or Monday as the first
day of the week.

Load entries starting from date: Check this box and set the date in the date picker to a date in
which you wish to load your entries from. When you start to use DayNotez over a period of years, it
may be wise to limit the number of entries that DayNotez Desktop loads into the application. Setting
this will allow it to only go "back so far" in what is loaded. This makes the user interface and loading
time faster in many cases. Leaving this unchecked means that your entire journal is loaded each time,
which may be fine if you have fewer entries.

Show progress dialog during synchronization with the handheld: Having this check tell the
DayNotez conduit to display a progress box during a HotSync. It gives you a visual indication of your
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entries being synchronized back and forth between DayNotez Desktop and your handheld.

See also:
· Day View Preference
· Entry Preference

· Custom Preference
· Spelling Preference

· Printing Preference

2.2.7.2 Day View Preference

This is the Day View section of the Preference dialog.

Day View settings.

Background Color: Allows you to choose a color for the background of the Day View screen.

Font: Font used for display in the Day View screen and also your Day View print outs.

Header Color: This is the background color that the "Date Header" (the very top panel in the Day
View) displays.

See also:

· General Preference
· Entry Preference
· Custom Preference

· Spelling Preference
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· Printing Preference

2.2.7.3 Entry Preference

This is the Entry View section of the Preference dialog.

Entry View settings.

Background Color: Allows you to choose a color for the background of the Entry screen.

Font: Font used for display in the Entry screen and also your Entry print outs.

New Entries: Settings for the default behavior of newly created entries.

· Private: Newly created entries are automatically set as "Private"

· Follow up flag: Newly created entreis automatically get the follow up flag set.

· Default to today's date: Newly created entries are assigned the current date by default.
· Default to this category: If your current category filter is set to "All", then assign this category,

otherwise it defaults to "Unfiled".

Note: If you do have a category filter set, the category assigned to new entries is set to the same
as the filtered category.
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Time Rounding: Settings for how DayNotez initially assigns the time for new entries.

· None: Inserts time to the exact minutes it is created.
· Quarter Hour: Rounds the time to the nearest quarter hour (15 min; :00, :15, :30, :45 ).
· Half Hour: Rounds the time to the nearest half hour ( :00 or :30 )

· Hour: Rounds the time to the nearest hour.
· Default Time: Sets the time to the time choosen here regardless of current time.

Auto URL Detection in editor:  Setting this turns on URL detection and launching within the entry
editor.

See also:
· General Preference

· Day View Preference

· Custom Preference
· Spelling Preference
· Printing Preference

2.2.7.4 Custom Preference

This is the Custom View section of the Preference dialog.

Custom View settings.

Custom List Options: These settings affect the custom "list" or "grid" portion of the custom view.
· Font: Font used to display the list items in the grid.
· Font: Font used to display the preview text in the grid.
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· Show lines between entries: draws the vertical and horizontal lines in the custom list.
· Enable Column Filters: Enables or disables the column filtering ability of the custom list (and thus

turning off the additional arrows in the column headers. This can be a cleaner look, but less
functional)

Preview Pane Options: These settings affect the Preview Pane portion of the custom view when
displayed.
· Background Color: Allows you to choose a color for the background of the Preview Pane.

· Font: Font used for display text in the Preview pane section and also used by your Custom View
print outs.

See also:
· General Preference

· Day View Preference
· Entry Preference
· Spelling Preference

· Printing Preference

2.2.7.5 Spelling Preference

This is the Spelling settings section of the Preference dialog.

Spell Checker settings.

Keep spell check 
window stationary: This option sets the behavior of the spell check dialog box that appears when

prompting you for spelling changes. Normally, the dialog will be positioned on
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the screen so as to avoid covering the text area in question. Some users may
wish to have the spell check dialog be stationary, remaining in the same
place all the time.

Check spelling
as you type This feature allow for DayNotez Desktop to spell check your entries as you

type. Spelling mistakes are automatically underlined in the entry area with a
red "squiggly" line. This feature is similar to how Microsoft Word does live
spelling. 

Correct spelling
as you type This feature also enable DayNotez to do "Auto Correction". A list of frequently

miss-spelled words is kept that can automatically be corrected as you type!

Use Aggressive
Context menu If you have problems right clicking on the live spell "squigglies" to get a

context menu of suggested words, then enable this option.

See also:

· General Preference

· Day View Preference

· Entry Preference
· Custom Preference

· Printing Preference

2.2.7.6 Printing Preference

This is the Printing section of the Preference dialog.
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Printing Preferences

Font: This is the font that will be used to print the body of your printouts. Prior to
version 1.2, the font used for printing was determined by the display font
used for each tab (Entry, Day View, Custom). This is no longer true. Fonts
are now restricted to "printer" fonts only.

Print Title As: Check this option to override the default page title (DayNotez) that prints at
the begining of each printing. The text that you provide in the input box next
to this option will be substitued instead. This is a way of personalizing your
printouts. You may also leave the text input box blank and no title will be
printed at all.

Print page header: Check this to have headers at the top of each printed page.

Gradient color...: Check this if you have a color printer and wish to have your entry headers
printed with a gradient color that is represented by the colors you have
defined in the categories preference. Some printers and systems can not
properly display this gradient, so you may need to disable it even if you do
have a color printer.

Print page footer: Check this to have footers at the bottom of each printed page.

· General Preference
· Day View Preference

· Entry Preference
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· Custom Preference
· Spelling Preference

2.2.8 Registration Dialog

The registration dialog allows you to register your copy of DayNotez Desktop.

Register Dialog

Once you have purchased a license to use DayNotez Desktop, you can enter the registration number
here. It is accessed by using the "Help->Register..." menu item.

DayNotez Desktop registration number begin with 056- or 057-. We recommend that you copy and
paste the number directly from your registration email sent from Natara Software. This avoid problems
with correctly identifying Zeros and O's, Fives and S's.

Note: If you ever loose your registration information, please visit the MyNatara web page to look
up your information. You will be prompted to enter the email address you registered with and then
presented with all of your information.

Note: If you have a registration number that begins with 052- or 054-, you have a DayNotez
handheld only license. Visit the MyNatara Web Page for information on upgrading to the DayNotez
Desktop version.

Hint: If you have multiple handheld devices that use DayNotez Desktop and synchronize with
the same PC, you can enter multiple licenses by separating them with a semi-colon ;. You can mix
Palm and Pocket PC licenses.

2.2.9 Spell Checker

These dialog are associated with the spelling feature of DayNotez Desktop.

http://www.natara.com/mynatara
http://www.natara.com/mynatara
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Spell Check Dialog

DayNotez provides a full featured spelling check component which gives it a more professional
look and feel. This spelling feature mirrors, and in some ways exceeds, the functionality of
several spelling check engines residing in commercial word processors. 

Starting with DayNotez Desktop v1.2, it is capable of learning the manner in which you
commonly misspell words and can improve its suggestions over time based upon this
information. It will move the more common misspelled words to the top of the suggestion list.

Live Spell feature

DayNotez is capable of providing the "little red squiggly underline" under misspelled words.
This is a common feature typically seen in commercial word processors. The DayNotez spell
checker mimics this look and feel very well. From a context menu you can choose to do nearly
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every operation normally available from a spelling check dialog. 

The spell checker is also capable of doing auto-correct as you type. If you add an auto-correct
entry that maps 'teh' to 'the', then if you type 'teh' in the edit control, it will be automatically
replaced with 'the'. 

DayNotez includes support for main dictionaries, custom dictionaries, and MS-Word custom
dictionaries. Any number of dictionary files can be open simultaneously. 

Custom features.

Custom dictionaries are dynamic lists of words to be ignored, words to be excluded (always
considered misspelled), and words to be corrected with other words (auto-correct). These
dictionaries are formed by you when adding a word or auto-correct entry while performing a
spelling check. 

2.2.10 Templates

These dialogs are associated with the management of entry templates (also known as "Entry
Templates"). 

(Entry) Templates are synchronized between the desktop and handheld.

(Entry) Templates allow users to save a predefined set of text and attributes which can easily be
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re-applied to entries. For example, maybe you are someone who takes meeting notes. For those
meetings, you always have a predefined layout for your text with simple labels marking the who, what,
when and where of the meeting. You also always categorize these meetings a "Business". Templates
makes doing this quite simple.

This is the Template list dialog. In the top portion you see a list of template name and their categories.
Buttons are provided to edit existing templates, create new ones, or delete selected ones. The
currently "Selected" template is marked in inverse and there is an indicator arrow on the left. (You can
not multi-select here)

The "Template Editor" is the dialog which allows you to create new or edit existing templates.
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Template Name: The template name is just text that identifies this particular template. The text is not
used as part of the actual template itself.

Options:
Private: If checked, the template will be marked as "Private" by default.

Category: The category to assign to the entry when the template is applied.

Set Time: If checked the template time is given to the entry.

Time: The time that will be set as default to the entry if the "Set Time" check box is marked.

Template Text: This is the actual text that will be inserted into the entry at the time it is applied. Text
is always inserted at the point in the existing text in which the cursor is at.

Note: If applying a template to an entry that already has existing text, the "Private" and "Set
Time" will be ignored. Category will also be ignored unless the existing entry has a category of
"Unfiled", in which case the Category will be applied.

Hint: You can apply templates to an existing entry as many times as you wish. Templates
simply "type for you" the text and attributes they contain.
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2.3 Toolbars

2.3.1 Main toolbar

The main toolbar consists of commonly used commands.

Main toolbar

New Entry: Creates a new DayNotez entry and switches the tab to the Entry view for input.
Delete Entry: Deletes the current DayNotez entry.

Cut: Cut the currently selected text to the clipboard.
Copy: Copies the currently selected text to the clipboard.
Paste: Paste the text in the clipboard to the active entry area.
Undo: Undo the last edit operation.

Insert Date: Inserts the current date stamp into the active entry area.
Insert Time: Inserts the current time stamp into the active entry area.
Insert Bullet: Starts a bulleted list.
Insert Numbered: Starts a numbered list.

Spell Check: Run the spell checker on your current DayNotez entry.
Find: Finds text in the current view. This only finds text within a single entry.
Print: Prints the current entry, or entries, depending on the current tab view.
Print Preview: Preview the printer output to screen before sending to the printer.

Preferences: Brings up the DayNotez Preference dialog.

(As if v1.6, the following are part of the "Category Toolbar" and are separately enabled and movable)

Category Filter: Filters the entries to only the selected category. Also used to edit categories.

Text Filter: Filters the entries based on a text string. This finds text in multiple entries.

2.3.2 Custom toolbar

The Custom toolbar contains buttons to access features that are particular to the Custom view.

Custom Toolbar

Group Box: The group box will show or hide the custom grid's grouping area.
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Group area

Field Chooser: This brings up the field chooser dialog.

Field Chooser

From this dialog you can drag hidden columns to the custom list of display, grouping, and sorting.

Auto Preview: This button toggles the display of the auto-preview text. Auto preview text is a 3 or 4
line listing of your entries text displayed beneath each entry in the custom list.

Preview Pane: This button toggles the preview pane located beneath the custom list pane. Use it to
hide the preview pane if you do not wish to see a preview of the currently selected
DayNotez entry while on the custom tab.

2.3.3 Entry details toolbar

The Entry Details toolbars are located within the entry tab. They consist of 3 parts which can be move
within the tab (or other parts of the DayNotez window) as you like.

Save Changes: This button is only active if unsaved changes have been made to the current entry.
This forces DayNotez Desktop to write the unsaved changes out to the data file.

Add Template: This toolbar button provides a drop down list of templates you have define for quick
entry. Select one and it is inserted into the current entry.

Entry Date: This control allows you to change the date that is associated with the current entry.
You can either manually change the date from within the control itself, using arrow
keys and number keys, or use the drop down calendar for easy selection via the
mouse.

Entry Time: This changes the time stamp associated with the current entry. Use the arrow keys,
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number keys, or spinner buttons on the right hand side to change the time.

Date/Time NOW: Clicking this button will for the current entry to be reassigned to the current date
and time (NOW).

Category: This is the category that is assigned to the current entry. Use the drop down list to
select a different category of your choosing.

Private: If checked, this entry is marked private.

Archived: If checked, this entry is marked as "Archived" from the handheld device. When
changing from non-archived to archived, the record will be removed from your handheld device during
the next synchronization.

Follow Up: Set or clear the follow up flag for an entry. Follow up flags can be use however you
see fit. They make it a quick and easy to use custom filters to search for important information or
entries you truly need to "follow up" on.

Contact: Allows you to assign a contact to the current entry. The contact field is not actually
tied into any contact database at this time, and can actually contain any text you like. The drop down
and "auto complete" ability of this control contains a unique list of contact entries you have used in the
past.

Keyword: User any type of keyword identifier you like here. This field also has a drop down and
"auto complete" of past used keywords to make reuse easier. Keywords are a great way to further
sub-categorize your entries. This makes the current Palm 15 category limit a lot easier to work with.

(Pocket PC only)

This toolbar, if not visible when editing a Pocket PC DayNotez data set, is available via the
"View->Toolbar" menu. It is ONLY available when working with a DayNotez for Pocket PC data set.

Font Selector: Use this dropdown to select the font you want to assign to selected text.

Font Size: Use this to adjust the font size of selected text.

B (Bold): Make selected text bold. (Note: Numbered lists are not supported. This is a limitation
of the Pocket PC edit control)

I (Italic): Make selected text italic.

U (Underline): Underline selected text.

Strikethrough: Strikethrough (StrikeOut) selected text.

A (font color): Apply a color to the selected text.
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Highlight: Apply a background highlight to selected text.

Align Left: Left align text.

Align Center: Center align text.

Align Right: Right align text.

Bullet List: Start a bullet list of items

Outdent: Outdent the current paragraph.

Indent: Indent the current paragraph.

2.3.4 Help toolbar

The help toolbar lets you quickly bring up the help file, or use the context sensitive pop up help.

Help Toolbar

What's This: The What's This button puts DayNotez Desktop into its context sensitive help mode.
Once the cursor changes to the "What's This" cursor, you can click on any control in
DayNotez Desktop to have it show you a short help text description of that control.

Help: Brings up the DayNotez Desktop help context menu.

2.4 Menus

2.4.1 File menu

These are the items under the File menu.

Open HotSync User...: Brings up the Open HotSync User dialog to set the currently active
DayNotez user.

Print: Prints the current DayNotez entry/entries, depending on your current tab that
is in view.

Print Preview: Brings up the print preview screen for viewing before you print.

Page Setup...: Allows you to make settings to your paper size, orientation, and margins.

Password Protect: Brings up the Password Protection dialog that allow you to set or clear the
current password for the current DayNotez data file.

Refresh Data: Refreshes the date from the DayNotez data file. This is useful if an outside
application has modified the DayNotez entries while the DayNotez Desktop
application was running.

Exit: Saves your entries and current preference settings, then exits the DayNotez
Desktop application.
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2.4.2 Edit menu

These are the items under the Edit menu.

Undo: Undo the last edit operation.

Cut: Cut the currently selected text to the clipboard

Copy: Cut the currently selected text to the clipboard.

Paste: Paste the text in the clipboard to the active entry area.

Select All: Selects all text in the active entry area.

Insert Time: Inserts the current time stamp into the active entry area.

Insert Date: Inserts the current date stamp into the active entry area.

Insert Bullet: Starts an un-numbered bullet list.

Insert Numbered: Starts a numbered list.

Spell Check: Start a spell check on the current entry

Find: Do a "find" within the current entry. This applies to the current entry only.

Edit Templates: Brings up the Template editor dialog.

Edit Categories: Brings up the category editor dialog.

Spell Check Options: Brings up the option dialog for spell checking features.

Edit Preferences: Brings up the Preference dialog.

2.4.3 View menu

These are the items under the View menu.

Toolbars: Allows you to toggle on and off which toolbars are visible.

Day View: Switches to the Day View Tab.

Entry View: Switches to the Entry View Tab.

Custom View: Switches to the Custom View Tab.

Group By Box: Shows or hides the Group By Box in the custom view list.

Field Chooser: Shows or hides the Field Chooser dialog.

Auto Preview: Enables or disables the display of the auto-preview text in the custom view list.

Preview Pane: Shows or hides the Preview Pane beneath the custom list area.

Show Private: Select to show or hide entries marked as private.
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Show Archived: Select to show or hide entries marked as archived.

Filter: Brings up the Filter Text pane to allow you to enter text to filter your entries on.

Voice Memo: Toggles between showing and hiding the Voice Memo control.

2.4.4 Entry menu

These are the items under the Entry menu.

New: Creates a new DayNotez entry.

Delete: Deletes the current entry (if you are viewing the Day View or Entry Tabs), or selected
entries if you are on the Custom tab.

Save Entry: This menu item is only active if unsaved changes have been made to the current entry.
This forces DayNotez Desktop to write the unsaved changes out to the data file.

2.4.5 Tools

These are the items under the Entry menu.

Import from other 
DayNotez Database 
(Pocket PC only): This menu item allows you to select another DayNotez user on your system to

import the data from. You can do this multiple times for the same database. However, it
will only import entry items with "unique IDs" that don't already exist in the current data
file. In other words, it will not re-add entries that where already imported in a different
session. It will not import items just because they were changed. The feature in not
meant to keep two data files in sync. It is meant as a facility of importing a Palm or other
Pocket PC data set into the current one so that you can continue on with entries on a
new device. This menu item is currently only available for Pocket PC users. Categories
are matched as much as possible. Categories that do not exist when importing will be
added. Templates and category colors are not imported.

2.4.6 Help menu

These are the items under the Help menu.

Context: Brings up the DayNotez Desktop help file.

What's This...: Put DayNotez into context sensitive help mode. The cursor will change to the
What's This cursor, and you can mouse click on any control to have it provide
a pop up help box about the item.

Search for help on...: Lets you search the help file for specific words, etc.

How to use Help: Provides help on using the help system.

DayNotez Palm User Manual: Launches the DayNotez Palm user manual in the Adobe Acrobat
reader.

Natara Web Site: Brings up your web browser and takes you to the Natara DayNotez web
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pages.

DayNotez Web Site: Brings up your web browser and takes you to the Natara DayNotez web
pages.

About...: Brings up the About Box

Register...: Brings up the Registration dialog.

2.5 Sorting, Grouping, and Filtering, and Exporting  the Lists

2.5.1 Columns list

This is a list of available columns you can add to the Custom list and a brief description of each.

Column Name Description

Archived
Icon that represents if the entry is marked as

Archived

Category Category name assigned to the entry

Category # The number of the category assigned to the entry

Contact The contact field text

Created The Date/Time that this entry was created
Date The short date of the entry

Days Since The number of days between now and the date
assigned to this entry

Follow Up Icon that represents if the entry has a follow up
flag set

Keyword The text of the keyword assigned (if any) to this
entry

Last Modified The Date/Time of the last modification of this entry
Month The Month value of the date assigned to this entry

Private
Icon that represent if the entry is marked as

Private

Text The first line of text of the entry

Time The time associated with this entry
Voice Memo Icon that represents if the entry has a voice

memo attached

Year The Year portion of the date assigned to the entry

2.5.2 Adding Columns

By default, DayNotez Desktop does not show all the available columns in the Custom list. You can
choose to show those columns if you wish.

To do this, select the "Field Chooser"  button from the Custom toolbar. This will display the field
chooser dialog box, labeled "Customize". This dialog lists all the columns currently not being
displayed.

Choose a column you wish to add and left click and drag it to the Custom list header section.
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Click and drag the column you wish to add.

Now, drop the column in the position you wish it to appear. Two green arrows appear to let you know
where the column will be added.

Drop the column in the column header.

Release the mouse button and the column is now part of the list. You can now close the Field
Chooser dialog box. 

New column has been added.

Note: DayNotez Desktop always remembers your column settings so they are the same the next
time you run DayNotez Desktop.

2.5.3 Sorting Columns

You can sort the columns of either the Entry List or Custom views list to however you desire. Simple
use your mouse to click on the column header.
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Sorting the Date Column

If you wish to sort the column in the opposite direction, click on the column a second time. The arrow
that appears on the right side of the column heading tells you that the list is sorted by this column,
and by which direction it is sorted.

Hint: You can have a secondary sort column by holding down the shift key and clicking on your
second column choice.

Hint: Sorting can also be applied to grouped columns in the Custom list.

2.5.4 Resizing, Moving, and Removing Columns

You can resize the columns in the Entry and Custom lists to suit your needs.

Position the mouse cursor directly between two column headings until you mouse pointer changes to
the resize cursor as shown below. Then click and resize the column.

Resizing a column

You can also move columns to a different order. Simply click the middle of the column header and
drag the column to the new position. Two green arrows indicate where you will reposition the column if
you release the mouse at that point.

Repositioning a column.

Remove columns by grabbing the column header and dragging it away until you see the cursor
change to indicate the column is removed. Once a column is removed, it is automatically added back
to the "Field Chooser" dialog so that you can use it again in the future if you wish.
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2.5.5 Grouping the Custom list

Grouping is a very powerful feature of the Custom list.

To group the custom list by a certain column, first be sure the grouping area is showing. If not, click

the "Group By Box"  button from the Custom toolbar. The Grouping area shows just above the
column headers.

Group area

Now, using the same process as in adding a new column, choose either an existing displayed

column, or one from the Field Chooser  to drag and drop a column to the Grouping area. Once
you place a column here, you list will now be grouped by that column.

Hint: You can even add a secondary group column, and sort the columns ascending or
descending. One particularly useful group setting to group by "Year", and then by "Month". Give it a
try!

You may wish to remove a group setting. To do so, click and drag the column you wish to remove out
of the Grouping area until you see the "No" cursor symbol as shown below. You can also remove
grouped columns and place them immediately back on the column header area.

Removing a Grouped Column

2.5.6 Text Filtering

DayNotez Desktop allows you to filter the list of displayed entries based on a text string. Use the text

filter button  on the toolbar to open up the text filter entry box at the top of the tabs window.

Text Filter entry window.

Enter the string you wish to filter on in the "Look For:" box, then click the "Find Now" button. This
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filters all entries that have that string present in them. To unfilter the lists, close the Text Filter entry
window by clicking on the toolbar button again, or by clicking on the X in the upper right hand corner
of the entry area.

The text is looked for in the entry note/text section, and also in the keyword field.

Note: The Text Filter is disabled when adding new entries. This prevents your new entry from
disappearing while you enter it if it does not contain a match for the filtered text.

2.5.7 Custom list filtering

When using the filtering capabilities of the Custom List, arrows are drawn to the right of column
captions.  To initiate a filter, click the appropriate arrow and select the necessary value to filter the
contents of your grid.  Filter arrows are displayed in blue in the columns that contain selected values. 
A filtered grid displays only the nodes that contain a specified value.  The grid pictured below is
filtered to display records with an entry time of between 1pm and 3pm:

You can filter a value by more than one column simultaneously.  The ExpressQuantumGrid supports
the following filter criteria:

Value Description

All Displays all nodes.

Custom Applies two criteria values within the current column using the comparison
operators AND or OR.
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Blanks Displays only the nodes that contain a False value in a column.

NonBlanks Displays only the nodes that contain a True value in a column.

Value Displays only the nodes that contain the selected value.

Use the [X] close box to the left of the Filter Status Bar at the bottom of the Custom grid to cancel the
current filter.

Note: The Blanks and NonBlanks options are available only if the column you want to filter
contains a blank cell. 

The Custom AutoFilter window allows you to determine two conditions for a column.  The editor type
for a value is determined by column type (for date columns, it is a date editor, for pick columns, it is a
pick editor, etc.):

Note: This filter only applies to the Custom list. It does not apply itself to the DateNav list like the
"Text Filter" does.

2.5.8 Exporting Entries

DayNotez has the ability to export your entries to various text formats. To do this, select the entries
you want to export in the Custom tab list. You can also use the "Control-A" key combination to select
all items in the custom list if you wish to export all the items. Keep in mind that "All" means all
currently visible/filtered items. If you have a filter or category selected, archived or private hidden, etc.
then those items are not available in the custom list. Once selected, right click the mouse button to
bring up the context menu for the custom view. 

Select the "Export" item, then one of the export types in the sub menu.
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In the picture above, selected items will be exported to an "HTML" formatted file. Current available
export types are:

Text: This is a plain text formatted file, suitable for viewing in any text viewer and great for including in
emails to others.

HTML: This will product a file formatted for viewing with a web browser. Greater for posting your
entries on a web site or importing into MS Word.

CSV: "Comma Separated Values". This is the "text" format that is useful for importing into other
applications such as a spreadsheet or database.

WordML:  This format is someone experimental and is only of interest to those that might be using
Microsoft Word 2003 or greater. WordML is an XML (eXtensible Markup Language) that is
understood by newer versions of MS Word.

After you select one of the available export styles, DayNotez will prompt you for a file name and
location to save to. Once saved, DayNotez will then prompt you to ask if you wish to "launch" the
saved file. If you save a Text formatted file, DayNotez will pass the file to the Windows operating
system and the default viewer for text files (.txt) will be launched to view the file. The same for goes for
the other formats.

Note: If you do not have MS Word 2003 or greater on your system, launching an exported
WordML file will simply show you the exported data in the default XML view, which is normally your
web browser.

2.6 Printing

DayNotez Desktop has 3 printing modes. Each mode is determined by which "Tab" you have active at
the time you choose to print.

If the active tab is:

· Day View: Your printout will consist of a chronological list of filtered entries for the currently
selected day.

· Entry: Your printout will consist only of a single entry, which is the currently viewed
entry in the Entry tab.
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· Custom: Your printout will consist of all the selected entries in the custom list.

If you are unsure of which entries you will be printing, it is recommended that you use "Print Preview"
to view the output prior to sending it to your printer.

Note: Bullet characters that show up on the handheld may not appear in printed text if you have
chosen a font which does not contain that character. Change to a font which does have the bullet
character (such as Ariel) to have them show on the screen and in your print outs.

3 How do I....

Common topics about how to do things with DayNotez Desktop.

3.1 Create a new entry

There are several ways to create new DayNotez entries within the application.

Note: If this is the first time you have used DayNotez Desktop, you will need to first do a
HotSync with your handheld device. This establishes the relationship between DayNotez Desktop and
your device and creates the desktop data file. After you hotsync, run DayNotez Desktop and choose
your HotSync name from the "Open HotSync User..." menu item.

Create: You can start a new entry by simply clicking on the New Entry icon in the toolbar , or by
selecting the menu item "Entry->New". Even easier yet is to just use the keyboard shortcut "Ctrl-N".
Doing any of these will take you directly to the "Entry" tab where you can start to enter text. (Also,
see the note at the bottom of the page)

Category: If you happen to have a category selected in the category filter at the time you create the
new entry, then that will be the category assigned to the new entry by default. If you are not filtered
on a particular category (the "ALL" category is selected in the main toolbar), then the category
assigned will be the one you have chosen as your default category in your Entry Preferences. Once
the new entry is create, you are free to change the category via the drop down category selector in
the top portion of the Entry Tab window. Keep in mind, that if you have a specific category selected
in your main toolbar (say "Business"), and you set the current entry to a different category (say
"Personal"), then the entry will be hidden once you move off the entry tab until you unfilter the
category settings or change the category filter to "Personal". (It's just hidden from view, so don't
panic).

Date: New entries are assigned a date dependant on your Entry Preferences setting for the date.
The date will either be the current date, or, the date that is the selected date on the calendar. 

Time: The default assigned time to a new entry is dependant on your Entry Preferences setting. It
can either be a pre-assigned default time of your choosing, the current time, or the current time
rounded to the nearest quarter, half, or hour setting.

Contact: You can enter a contact or name to associate with the entry via the contact entry box
which is by default displayed at the bottom of the entry page. (If the field isn't visible, use the
"View->Toolbars->Contact" menu item to show it again). You can quickly get to the field by using
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the shortcut "Alt-C".

Note: One very handy feature is the ability to create new entry by holding down the Control key
while clicking on a calendar date. This creates a new entry and sets the date of the entry to the clicked
date, regardless of your preference settings.

3.2 Archive an entry

To "Archive" an entry with DayNotez Desktop means this

Archive: To remove a entry or entries from the handheld device but keep them available for viewing
and editing on the desktop.

You can archive entries from your handheld in several ways.

From the handheld: On the handheld device while running DayNotez, you mark entries for archival
during the next hotsync. To do this, you can select to "Delete" the entry. The delete dialog which is
displayed at that time will have an option to "Save archive copy on PC". When the next HotSync
occurs, the entry will be removed from the handheld, but still remain on the desktop. You can also
choose to "Purge" multiple entries based on their category and date. The same "Save archive copy on
PC" option is available at that time which archives your entries to help you save valuable space on
your device.

From the desktop: There are a couple of ways to archive entries via DayNotez Desktop. When
viewing an entry in the "Entry" tab, there is a checkbox which allows you to mark the entry as
archived. A more powerful way of doing multiple entries is via the "Custom" tab. There you can sort or

group into logical groupings, select any number of entries you wish, then right click and choose 
"Archive" to mark multiple entries for archival during the next hotsync.

Un-Archiving: This process will restore archived entries back to your handheld device from the
desktop. Of couse, this can only be done from DayNotez Desktop. Just follow the steps above except
for choose "Un-Archive" from the "Custom" tab, or un-check the "Archive" checkbox 

Warning: If you synchronize DayNotez with multiple desktops (each having either DayNotez
Desktop or DayNotez for Outlook), then you must remember to mark the same entries as "Archived"
on the second desktop prior to HotSyncing with the second desktop. Failure to do so will result in the
archived entries being restored to your device. After an entry is archived to the first desktop, it is
removed completely from the device. When you HotSync with the second desktop, if the entry isn't
already marked as "Archived" on the desktop, the DayNotez conduit will assume that the entry is a
new entry (since it doesn't see it on the handheld) and put it back on. The conduit skips entries that
are marked as "Archived".

Note: Currently, DayNotez Desktop does not support the archival of entries from the desktop
database to an external file. Archiving entries in this fashion is something we hope to accomplish in a
future version of DayNotez Desktop. We also hope to support "Export" capabilities to other file formats
sometime in the future.
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3.3 Change the date of an entry

There are several ways to change the date of an entry. Most users will probably want to change the
date of an individual entry. This is usually accomplished from the Entry Tab. The date control in the
entry toolbar can be modified by either directly typing in a desired date, or by using the drop down
calendar to visually select a date.

If you want to change multiple entries to the same date, then the Custom Tab is the place to do it.
From there, you can select the entries you wish to modify, right click, and choose the "Date..." menu
item. 

Another way to change the date of entries is to drag and drop them from either the DateNav list or the
Custom list directly onto a date on the DateNav calendar. Just change the calendar so that it is set to
the month the desired date is on, select one or several entries from the list (multiple only from custom
list) and drag them over to a particular date on the calendar. The entries will automatically be updated
with the new date.

Note: Although DayNotez Desktop let you display 3 different dates for each entry ( Created On,
Modified, Entry), only the entry date is modifiable. The Created On date always reflects when the entry
was originally created, and the modified date is updated any time a change is made to the entry.

3.4 Find a particular entry

There may come a time when you need to find a particular item in your DayNotez entries. The easiest
way to do this is from the "Custom" tab. 

Unless you are certain of the category that the entry is in, be sure to select the "All" category from the
main toolbar.
 
Now select the "Filter" button in the toolbar if the Text Filter entry area isn't visible. Enter a keyword
that you are looking for. For example, if you remembered making an entry about seeing a Bluebird on
a particular day, but can't remember when, enter "Bluebird" in the text box and select the "Find Now"
button.

DayNotez will search all of the records in the current category (or ALL) for any containing the word
"Bluebird" and will present you with a filtered list of the valid entries. You can select each entry, one at
a time and view their contents via the preview pane or via the "Auto Preview" text feature of the list. 

If you wish to modify the entry, double click on it and you will be taken to the "Entry" tab.

3.5 Backup my data files

It is important that you periodically make a backup of your DayNotez Desktop data files in case of a
hard disk failure on your desktop. Actually, this rule applies to any important information you maintain
on your computer that would be hard to reproduce if it were ever lost. Natara highly recommends
backing up your data with a good quality backup application that will store your information to a
removable media (such as CD-R, Zip, or Tape for example).

If you wish to make periodic backups of your DayNotez Desktop data, there are two files of interest to
you. For example sake, lets say your HotSync User Name is "J. Doe". DayNotez keeps two files for
each device that it synchronizes with. Those files are currently kept in the DayNotez installation
directory. By default, the DayNotez installation directory is on your main hard disk partition (usually
your C: drive) in the path "C:\Program Files\Natara\DayNotez\". The file are prefixed with your
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HotSync name, and end in the extensions .DNZ and .MDW. (you will need to have windows
configured to show extensions in order to view the full name).

For our example, the two important files that need to be backed up are:

"J. Doe DayNotez.dnz" and "J. Doe DayNotez.mdw".

The .DNZ file is the file that actually contains all of your entries. It will grow as you add more and more
data to your DayNotez file. The .MDW file is is the security file used in case you password protect your
entries. This file will only change if you modify the password protection status or password, and so
changes very little. It is important that you keep both files backed up. Without the .MDW file, you may
not be able to access your entries. Since the DayNotez entry file is encrypted regardless of if you
password protect your entries or not, the .MDW file is always used to de-crypt it for viewing. Using
someone else's .MDW file will not work.

Note: Starting with DayNotez Desktop 1.5, the default location for any newly created user data
files is "My Documents"\Natara\DayNotez\. This will allow for better separation of the DayNotez
application and the user data (which is easier to make regular backups in most cases). Note that only
newly created data files get put in this location. A future release of DayNotez Desktop will allow users
to move their data files to locations other than the default installation or "My Documents" folders.

Note (Palm Users): Once any conduit, such as DayNotez Desktop's conduit, is installed, the
Palm HotSync Manager stops making backups of any data files associated with the palm application.
So, since DayNotez (Desktop) has a conduit, its palm native data file that has all of your entries,
named DayNotezDB.PDB, will no longer be backed up. In general, this is not a worry since the
conduit is making a copy of all of your entries. But what if you want that extra protection of having the
.PDB file backed up? Natara software highly recommends a HotSync Manager backup enhancement
program such as Blue Nomad's BackupBuddy ( http://www.bluenomad.com ). With this application
installed, a backup of your .PDB files is still made for even applications that have conduits associated
with them. Highly recommended!

3.6 Save my entries to a text file

You can export your DayNotez entries to a text formatted file. Please see this section of the use
manual.

3.7 See only "Follow Up" items

Sometime you want to quickly view only those entries which you have marked with the "Follow up"
flag. This is quite easy to do. 

This is done from the "Custom" list. First, make sure that you have the "Follow up" column available in
the list. If you do not have it showing, take a look at the "Adding Columns" section of the manual. Now
use the Custom Filtering drop down menu on the "Follow up" column and select the "True" option.
Once selected, your custom list should be filtered to only show you items with the follow up flag set.

Alternatively, you can drag the "Follow Up" column into the grouping section and group your entries
by "Follow Up" and no follow up settings.

http://www.bluenomad.com
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3.8 Print a days worth or entries

To print a full days worth of entries, simply select the day on the calendar and switch to the Day View
tab. Now use the Print or Print Preview buttons or menu items to print that days entries. The print
feature does not print each entry on a separate day, but one after another.

3.9 Print multiple entries

To print mulitple entries out one after another, switch to the "Custom" tab. Now sort or group your
entries in any way you wish and select the ones you want printed. If the entries are listed all in a row,
you can simply select the top entry with the mouse, then shift-click on the last entry to mark an entire
block. If you want to print multiple "random" entries, click the first entry, then Control-Click any other
you want added to the list.

Once you have your entries selected in the custom list, simply select the Print or Print Preview toolbar
or menu items. Entries will be printed one after another (saving paper instead of printing them each
on a new sheet). Keep in mind when printing from the Custom view, entries are printed in the order
they appear in the list. Changing the sort order of the custom list changes the order the entries are
printed. If you are not sure, pick "Print Preview" to have a look at what the printout will look like prior to
going to the printer.

4 Reference

4.1 Keyboard Shortcuts

4.1.1 General command shortcuts

Here are some generally used keyboard shortcuts.

Ctrl-N: New Entry
Delete: Delete current entry/entries
Ctrl-S: Save any unsaved changes to your entries
Alt-T: Template Select
Alt-D: Enable the Date Chooser control

Ctrl-T: Insert time stamp
Ctrl-D: Insert date stamp

Ctrl-8: Insert bullet list
Ctrl-9: Insert Numbered list

F7: Spell check

Ctrl-1: Switch to Day View tab
Ctrl-2: Switch to Entry tab
Ctrl-3: Switch to Custom tab
Ctrl-Tab: Rotate through tabs

Shift-Ctrl-F: Enable the Text Filter panel

4.1.2 Editor shortcuts

Here are some shortcut keys to use while editing DayNotez entries.
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Ctrl-C: Copy selected text to clipboard
Ctrl-X: Cut selected text to clipboard
Ctrl-V: Paste text in clipboard to current entry selection
Ctrl-Z: Undo the last change

Home: Move cursor to beginning of line
End: Move cursor to end of line
Ctrl-Home: Move cursor to top of entry
Ctrl-End: Move cursor to bottom of entry
PgUp: Move cursor up a page
PgDn: Move cursor down a page

Double-click: Selects the word under the cursor
Ctrl-Right: Move right by a word
Ctrl-Left: Move left by a word
Shift-Left: Select characters left
Shift-Right: Select characters right

Delete: Delete character from the right
Backspace: Delete character from the left
Ctrl-Delete: Delete from cursor to end of line

Shift-Ctrl-[: Outdent paragraph
Shift-Ctrl-]: Indent paragraph

(Pocket PC Only... Rich Text)

Ctrl-B: Bold
Ctrl-I: Italic
Ctrl-U: Underline
Ctrl-8: Bullet List

4.2 Frequently Asked Questions

4.2.1 Installation

Q: Do I have to reinstall when I get my DayNotez registration code?

A: No. Your installation of DayNotez can be converted from the a trail to a registered version by
entering the registration code. Tap on the "Register" menu item on the Help menu

Q: I lost my registration number, what should I do?

A: Check the "MyNatara" web site for all your information.

Q: Can I get a CD with the program on it?

A: Natara Software does not ship any CDs. The latest versions of all the Natara Software
products are available online.

http://www.natara.com/mynatara
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4.2.2 Desktop

Q:Can I HotSync DayNotez with 2 different PCs?

A: Yes, you can synchronize DayNotez to 2 different desktops PCs. Be aware that if you archive
entries on one desktop, you will need to manually mark them as archived on the other. If you
don't, the archived entries will be added back to your handheld from the second machine the next
time you sync with it. Otherwise, it should work just fine.

Q: I want to sync to DayNotez Desktop with two different Palms. Do I need another license?

A: Yes. Natara products are licensed for use on a per-Palm basis. In order to HotSync multiple
devices to the desktop applications, you will need to purchase additional licenses.

Q: I want to sync to DayNotez Desktop with two different Palms. Can they share the same
data?

A: Not really. DayNotez saves the data for each handheld to separate files based on the HotSync
User name.

Q: Can I use the same desktop with both a Palm and Pocket PC device?

A: Yes, but the data is not synced between two devices. They are treated as different users.

Q: Can I sync two Pocket PC devices with the same data?

A: Yes. Two Pocket PC devices can share the same desktop data and keep in sync.

Q: Does DayNotez work with Windows Mobile Smartphones?

A: No. "Smartphones", as defined here, are devies that have Windows Mobile OS on them, but
do not have a touch screen for input. DayNotez WILL work with Pocket PC Phone Edition
devices. That includes the Palm Treo 700w device (which is technically NOT a Windows
Smartphone device...but is called a "smartphone" anyway by Palm)

4.2.3 Misc.

Q:What happens when my trial period runs out?

A: After the trial period, the ability to create new notes, and synchronize is disabled. Once the
product registration key is entered, this ability will be enabled.
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Note: If, after the trial period, you decide NOT to purchase a license, you should uninstall the
product. Failure to do so will result in HotSync Manager not backing up your DayNotez Palm data,
and you run the risk of loosing your entries if your device crashes and needs to be restored. HotSync
Manger, by default, stops making backups of data file for any Palm application that has an installed
conduit (such as DayNotez Desktop). 

Q: What does Natara charge for new versions of the application?

A: Natara Software normall provides minor released free of charge (eg: 1.2 to 1.3, etc.). We will
continue to offer free updates, but reserve the right to charge for a major release (eg: 1.2 to 2.0 to
3.0, etc.) in the future.

Q: I have suggestions for feature enhancements to one of your products. What is the best
way to let you know about them?

A: You should join and post your feature requests on the Natara User Forums. Each product
forum section has a "Feature Request" thread. By posting your request there, others can also see
your suggestions and Natara can get a better feel for the overall demand for particular
enhancements.

4.3 Updating from versions prior to v1.2

Version 1.2 of DayNotez Desktop uses a new secure data file format that allows you to password
protect your entries. Because of this, DayNotez Desktop needs to convert your older data file into the
newer secure format.

The first time that DayNotez Desktop v1.2 is used to open a pre-v1.2 data file, it will start the process
of converting the data to the newer format. You should see a progress dialog that looks like the
following:

Data Conversion Progress Dialog

http://www.natara.com/forums
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NOTICE: Upon completion of the conversion, DayNotez Desktop leaves backup of the non-secure
data file in your DayNotez Desktop installation directory (usually c:\program files\natara\daynotez\ ).
This backup file has an extension of .bak and should be removed from your system once you are
confident that the conversion was successful. After the conversion is complete, DayNotez Desktop will
open the new data file. If all seems normal, then the conversion was successful. This backup file is left
on your system just in case there are problems with the conversion process and you need to start
over. For example, if your HotSync User Name is "Jane Doe", then the file you need to remove is "
Jane Doe DayNotez.dnz.bak". DO NOT remove the file "Jane Doe DayNotez.dnz". 

If you feel that the conversion process was not successful, then please contact Natara Support at 
Support@natara.com  for further assistance.

4.4 MDAC and Jet OLE Drivers

DayNotez Desktop and it's conduit rely on Microsoft's Data Access Components.

What are the Microsoft Data Access Components?

The Microsoft Data Access Components are the key technologies that enable Universal Data
Access. They include ActiveX Data Objects (ADO), Remote Data Service (RDS, formerly
known as Advanced Data Connector or ADC), OLE DB, and Open Database Connectivity
(ODBC)

Simply put, it is a bunch of computer components that allow 3rd party developers such as Natara, a
standard way of accessing database files, such as the DayNotez Desktop user data files. DayNotez
Desktop utilizes a part of the MDAC called "Jet OLE 4.0".

Natara Software does not supply the MDAC components with its installation for several reasons.
· Most users with up to date operating systems will already have the necessary components installed.

They are installed by a lot of Microsoft tools, such as Outlook and some newer versions of IE.
· The MDAC is an installation process in itself. It is somewhat complex, and is best left to the

Microsoft installation procedures to install the necessary parts for the operating system you happen
to be using.

· Downloading the installation portion of the MDAC every time there was a new release of DayNotez
Desktop would be wasteful, since the MDAC portion never gets changed by Natara Software
anyway.

If, after installing DayNotez Desktop and doing a synchronization you receive an error message in you
hotsync log such as

"DayNotez DB Database Access Error Microsoft ADO may not be properly installed on
machine"

...you may need to install ( or re-install ) the MDAC drivers. 

Note: Natara Software currently recommends MDAC 2.8 or higher. You can find links to

mailto:support@natara.com
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Microsofts MDAC and Jet downloads at the Natara MDAC infomation page

4.5 Spell Check Dictionaries

Note: Starting with DayNotez Desktop 1.5, the english dictionary is now shipped with the
product. Simply assign it from within the Spelling options. For other languages and updates, please 
check the Natara web site.

In order to use the Spell Check feature of DayNotez, you will need to download a dictionary.
Dictionaries can be found on the Natara Web Site Dictionary Page in multiple languages.

We do not supply multiple dictionaries with the DayNotez Desktop installation program for a couple of
reasons:
· The dictionaries rarely change and only need to be downloaded once. We wouldn't want you to

have to download it with each update of the product.
· We don't know exactly which language each user would prefer, so this gives you a chance to

download a the dictionary of your choice once and not have to do it again.

You can also download specialized dictionaries, including ones with legal words, technical, medical,
etc.

1. Once you download the dictionaries you plan to use, you must unzip* them to a directory of your
choice. We recommend putting them directly into the DayNotez installation directory, which is
usually \program files\Natara\DayNotez.

2. Run DayNotez Desktop and go to the Entry tab.
3. From the "Edit" menu, select the "Spell Check Options..." item.
4. Select the "Options" button in the spell check dialog.
5. In the "Dictionaries" section, click on the "Locate Dictionaries..." item in the window (see below).
6. This brings up a directory selection dialog. Navigate through this window to the directory that you

unzipped your dictionary files to.
7. The "Dictionaries" section should now contain a list of all the dictionaries that were found in the

directory. Select the checkboxes of the ones you wish to use.

Visit the Natara DayNotez download page for more information 
http://www.natara.com/DayNotez/Dictionary.cfm :

http://www.natara.com/daynotez/mdac.cfm
http://www.natara.com/DayNotez/Dictionary.cfm
http://www.natara.com/DayNotez/Dictionary.cfm
http://www.natara.com/DayNotez/Dictionary.cfm
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Note: If you are unfamiliar with "un-zipping" things from the internet, you should download and install
"WinZip". You can find "WinZip" at http://www.winzip.com. 

.

 

4.6 Contacting Natara Software

Questions, comments, or bug reports?

Email: 
support@natara.com 

Online: 
http://www.natara.com 

Natara User Forums: 
http://www.natara.com/forums  

http://www.winzip.com
mailto:support@natara.com
http://www.natara.com
http://www.natara.com/forums
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If you are having problems with our product or wish to report a bug, please first look
in the following locations to see if we have already provided some help or the issue has
already been reported by looking at the following locations:

The Natara Support Pages
The Natara User Forums

If you do not see an answer to your question and do not feel like posting in our forums,
please feel free to email us.

Note: When reporting problems, be sure to be as specific as possible. 

Include:

· Which product you are having trouble with (DayNotez on Palm, DayNotez for Pocket PC, DayNotez
Desktop)

· Palm OS version (4.1, 5.4, etc.)

· Pocket PC OS and device type.

· Palm Desktop version (HotSync version)

· ActiveSync version
· What desktop operating system ( Windows 2000, XP, Windows ME, etc.)

· Steps to reproduce the problem.

· (Palm Uses) It is also very useful to provide a copy of your latest HotSync log file. That file usually
contains error messages reported by the DayNotez Desktop conduit during hotsync operations.

4.7 End User License Agreement

-IMPORTANT-

Read This Carefully Before Installing The Software

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND NATARA SOFTWARE, INC. BEFORE
CONTINUING WITH THE INSTALLATION OF THE PROGRAM, YOU MUST READ,
ACKNOWLEDGE AND ACCEPT THE TERMS AND CONDITIONS OF THE SOFTWARE LICENSE
AGREEMENT WHICH FOLLOWS. WHEN PROMPTED, PLEASE INDICATE WHETHER YOU
ACCEPT OR DO NOT ACCEPT.  IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF
THE SOFTWARE LICENSE, YOU MAY RETURN THE MEDIA PACKAGE AND ALL
ACCOMPANYING ITEMS (INCLUDING WRITTEN MATERIALS AND BINDERS OR OTHER
CONTAINERS), TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND; OR YOU MAY
WRITE, NATARA SOFTWARE, INC., 909 E. OGDEN AVE. SUITE C, NAPERVILLE, IL 60565.

NATARA SOFTWARE LICENSE

1. GRANT OF LICENSE.  Natara Software, Inc. ("Natara"), grants to you, the end user, a personal,
nonexclusive license to use a single copy of this software program, including any updates, additional
modules, or additional software provided by Natara in connection therewith (the "Software"), solely for

http://www.natara.com/support
http://www.natara.com/forums
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your own use, and solely in  accordance  with the terms and conditions of this license agreement. 
You may copy the Software into the memory of any computer, solely as necessary to use the Software
in accordance with this license agreement.

2.   INSTALLATION AND USE.  Natara DayNotez is licensed to you in one of two potential
configurations:  (1) Single User License and (2) Evaluation License. You may install and use (in the
manner provided) only those configuration(s) for which you have obtained a license. Licenses for
Natara DayNotez are individual named user licenses. No license may be shared, in any capacity, by
more than one individual end user.  

(1) Single User License.  You may install and use a single copy of the Software on a single
handheld device. You may install the software on up to two (2) computers that 
the handheld device synchronizes with.  You may access the Software from a hard disk, over a
network, or by any other method; strictly in accordance with the terms hereof. You may use each
licensed copy of the Software on up to two (2) computers and a single handheld device.

(2) Evaluation License.  You may use one copy of the Software on a single computer and handheld
device, for a period not to exceed thirty (30) days. You are acquiring only the limited right to use a
single copy of the Software for evaluation purposes. You are not acquiring any rights to the Software
itself.

 
3. COPYRIGHT AND COPIES.  The Software (including any copy thereof), is owned by Natara or its
suppliers and is protected by United States copyright and patent laws and international treaty
provisions.  The Software copy is licensed, not sold to you, and you are not an owner of any copy
thereof.  You may either (a) make one copy of the Software solely for backup or archival purposes, or
(b) transfer the Software to a single hard disk provided you keep the original solely for backup or
archival purposes.  You may not otherwise copy the Software except as expressly authorized by
applicable law, and you may not copy the written materials accompanying the Software.  Natara
hereby reserves all rights not explicitly granted in this software license agreement.
 
4. OTHER RESTRICTIONS.  You may not rent, lease or transfer the Software.  You may not reverse
engineer, decompile or disassemble the Software, except to the extent expressly authorized by
applicable law.  
 
5. LIMITED WARRANTY AND REMEDY.  Natara warrants the physical media (e.g. diskette(s) or
CD-ROM), and the physical documentation, to be free of defects in materials and workmanship for a
period of  90 days from the original purchase date.  If Natara receives notification within this warranty
period of any such defects and such notification is determined to be correct, Natara will, at its sole
option and discretion, repair or replace the media or documentation, or provide you a full refund.  The
foregoing is your sole and exclusive remedy and states Natara's and its suppliers' entire liability arising
out of this warranty.  This limited warranty is void if the damage or defect has resulted from accident,
abuse or misapplication.
 
6. NO OTHER WARRANTIES.  THE LIMITED WARRANTY ABOVE IS EXCLUSIVE AND IN LIEU
OF ALL OTHER CONDITIONS AND WARRANTIES FOR THE SOFTWARE AND
DOCUMENTATION.  NATARA AND ITS SUPPLIERS MAKE NO OTHER CONDITIONS OR
WARRANTIES, EXPRESS, IMPLIED,  STATUTORY OR OTHERWISE, AND EXPRESSLY
DISCLAIM ALL OTHER CONDITIONS AND WARRANTIES, INCLUDING BUT NOT LIMITED TO
IMPLIED CONDITIONS OR WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NONINFRINGEMENT FOR THE SOFTWARE AND
DOCUMENTATION, TO THE FULLEST EXTENT PERMITTED BY APPLCABLE LAW.  
 
7. LIMITED LIABILITY.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO
EVENT AND UNDER NO LEGAL THEORY SHALL NATARA OR ITS SUPPLIERS BE LIABLE TO
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YOU FOR ANY COSTS OF SUBSTITUTE PRODUCTS, OR FOR ANY CONSEQUENTIAL,
SPECIAL, INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF
THE LICENSE OF, USE OF, OR INABILITY TO USE ANY NATARA SOFTWARE OR
DOCUMENTATION, EVEN IF NATARA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.  IN NO EVENT SHALL NATARA'S OR ITS SUPPLIERS' LIABILITY EXCEED THE
LICENSE FEE PAID BY YOU.  THIS LIMITATION OF LIABILITY AND RISKS IS REFLECTED IN
THE PRICE OF THE 
SOFTWARE LICENSE.  
 
8. TERM.  This license is effective until terminated. You may terminate it at any time by destroying the
Software together with all copies, modifications and merged portions in any form.  It will also terminate
automatically upon your failure to comply with any term or condition of this Agreement.  In the event of
such termination, you agree to promptly destroy the Software together with all copies, modifications
and merged portions in any form. 
 
9. MISCELLANEOUS. This is the entire Agreement between you and Natara, and supersedes any
prior agreement, whether written or oral, relating to the subject matter of this Agreement.  This
Agreement is governed by the laws of the State of Illinois, U.S.A., without reference to conflict of laws
principles. All disputes arising out of this Agreement shall be litigated or otherwise resolved exclusively
in the state of Illinois.  If any provision of this Agreement is ruled invalid, such invalidity shall not affect
the validity of the remaining portions of this Agreement.
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